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1 Description of software

1.1 Introduction to Merida Signals

IAV Merida Signals is a tool designed for viewing measurement files collected from vehicles. These files are
usually created using devices called data loggers. As the name of the tool suggests, IAV Merida Signals uses
MDF (Measurement Data Format) as its main format, in which specific data obtained from measurements
can also be exported.

1.2 Application areas

A distinctive feature of IAV Merida Signals is that it enables the variety of file formats, e.g. various raw data
formats from data loggers, to be read without converting them into a special format, such as MDF, before
displaying. Support of raw data formats requires that the appropriate data description formats (e.g. data
base CAN (dbc)) are also supported in order to obtain information in the form of signals from the messages
(e.g. Controller Area Network (CAN)) recorded by data logger. This additional information can be processed
by 1AV Merida Signals after having been measured.
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2 Installation

This section describes system requirements for using 1AV Merida Signals, how to install and activate the

software.

2.1 System requirements

The Windows operating system is required to use IAV Merida Signals. Depending on the type and size of
the measurements to be viewed, a large amount of memory may be required. This requirement comes from
the necessity for the computer to load and store all the measurement units in its RAM.

2.2 Software installation

IAV Merida Signals is delivered as an executable installer.

To install the software, follow the steps below:

1. Click on IAV Merida Signals to download the tool.

2. Move to the download button and download MeridaSignals-Setup.zip.
3. Run the installer.
4. Follow the instructions on the screen.

Afterwards, IAV Merida Signals can be launched using an icon on the desktop or in the Start

menu.

NOTE
% Before downloading Merida Signals, please ensure that the policies or restrictions of your
company permit the installation of the latest version.

2.3 Activation

When started for the first time, 1AV Merida Signals must be initially activated.

In order to activate the software, you need to register a user to 1AV Merida.
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NOTE

= Each user is allowed to install the software on up to two computers.
= The licence is usually granted for 180 days.

= Every time the software is started, the license will be automatically renewed, assuming
an internet connection is available.

To activate Merida Signals, follow the steps below:

1. Double-click Merida Signals on your desktop to launch.

2. If you don't have an IAV Merida account, please press the Register button (see Figure 1) and
a new browser window opens.

Signals login X
User
Password
Cancel Register Forgot Password Login
Figure 1: The Login window
3. Fill the form with your data and click on Register (see Figure 2).
4. After that you will receive an email to confirm the activation of your account.
5. When the registration process is finished you can close the browser and proceed to enter your

username and password to the login window (see Figure 1)

After successful login, a license is automatically requested and saved to your local computer, and the Main
window of AV Merida Signals opens (see Section 3. Structure of the Main window to get familiarized with
the key elements of IAV Merida Signals).
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Register

* Required fields

Username *

Password *

Confirm password =

Email =

First name =

Last name =

Company

Department

(L] By signing up you agree to our Terms and Conditions and
Privacy Policy.

« Back to Login

Figure 2: The register form
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3 Structure of the Main window

The Main window is divided into three areas: the Signal list, the Signal groups and the Plot panel.

@ v

b ¥~ T T -t 1 - T8 &

Figure 3: The Main window

At the top of the Main window, you can find the Menu and the Toolbar. They contain a set of options like
File, Scaling, Signal, etc. to help you find information and/or execute different functions when operating
with your measurement files.

3.1 Settings

In the File menu you can find the settings. In the dialog you can edit general settings regarding file types
and visualization properties.

3.1.1 File formats

MDF4

MDF4 files are handled per default with lazy loading. This means, signals are only read from file when
needed. If you deactivate this setting the whole data from the file is read to memory as soon as the file is
opened.

CSsv
CSV files have following options:

= Timestamp resolution: E.g. "1" for seconds and "0.001"” for micro seconds

n.on

= Column separator: The symbol which separates the columns in the file (usually or",")

3.1.2 Colour scheme

Using the Colour scheme options (see Figure 4), colours for signals, background, grid and text can be set.

The following is possible:

= Opening a colour scheme
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Figure 4: The Settings window > Colour scheme

= Setting a colour scheme

= Creating a colour scheme

= Setting the colour of signal, background, grid and text

= Adding, deleting and setting the sequence of the signal colours

= Editing a colour scheme

= Deleting a colour scheme

Opening a colour scheme

To open a colour scheme, follow the steps below:

1. Press Settings in the File menu.

2. Press Colour scheme in the left-hand sidebar of the Settings window (see Figure 4).

As a result, a space with various ‘Colour scheme’ instruments is opened.

Setting a colour scheme

In AV Merida Signals it possible to set one of the standard 1AV schemes. However, you can also create your
own and set it.

To set up a colour scheme, follow the steps below:

1. Open a colour scheme in the Settings window (see Opening a colour scheme).

2. Click on the Scheme field.
3. Select the desired colour scheme from the drop-down list.

4. Click OK to confirm.
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NOTE
The scheme activated at the moment when you leave IAV Merida Signals is by default
applied when the application starts next time.

Creating a colour scheme

To create a colour scheme, follow the steps below:

1.

Open colour scheme in the Settings window (see Opening a colour scheme).
Press Add icon +  at the top right corner of the window.
Enter the name of your colour scheme in the Scheme field.

Click on Enter key to save the name.

CAUTION
Only after naming and saving, any setting and editing of your scheme is pos-
sible.

Select the colours for signals, background, grid and text of your colour scheme (see
Setting the colour of signal, background, grid and text).

Click OK to save the scheme.

After confirming, your colour scheme will be applied to the representation of signals and
elements of the Graph on the Plot panel.

Setting the colour of signal, background, grid and text

To set the colour of signal, background, grid or text, follow the steps below:

1.

Click on the colour square . to the right of the necessary object.

Once this square is activated, the brush symbol will appear inside of it.

Select a colour using Swatches or adjust the parameters of the colour in colour models HSV,
HSL, RGB, CMYK.

Adding, deleting and setting the sequence of the signal colours

Only for signal colours there is a possibility to choose multiple colours, ordering, adding or deleting as many

new colours as necessary in accordance with the number of signals. These options you can find to the right

of the title

‘Signal colour’ (see Figure 5).

To add signal colours, follow the steps below:
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Figure 5: Options for changing signal colours

1. Press Add icon + (see Figure 5).

After it is pressed, a white square with the brush symbol will appear, where you can set
the signal colour.

To set the sequence of signal colours, follow the steps below:

1. Press on the colour square that you want to move.

2. Press Left arrow icon =« or Right arrow icon = to change the position of the activated
signal colour in the line.

To delete signal colours, follow the steps below:

1. Press on the colour square that you want to delete.

2. Press Delete icon 0 .

Editing a colour scheme

To edit a colour scheme, follow the steps below:

1. Click on the Scheme field.
2. Choose the colour scheme you want to edit.
3. Make changes.

4. Click OK to save the changes.

CAUTION
Editing a colour scheme is only possible for the schemes created by your own.

Deleting a colour scheme
To delete a colour scheme, follow the steps below:

1. Select a colour scheme that you want to delete in the Scheme field.
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2. Press Delete icon 7 at the top right corner of the window.

CAUTION
Deleting a colour scheme is only possible for the schemes created by your own.

3.1.3 Frame representation

The frame representation settings control how frames are displayed in text form. These text representations
are used in the cursor window and the trace frame.

The following is possible:

= Activate or deactivate the truncation of frame data. The following options only apply if this option is
active.

= Set a maximum number of displayed elements for arrays in SOME/IP frames.

= Set a maximum number of bytes in the raw (hexadecimal) representation of byte arrays, e.g. in
ethernet frames.
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4 Operating with measurement files

This section describes the functions that are sufficient to open measurement files correctly.

4.1 Basic terms

This sub-section is devoted to the description of the main terms used throughout the manual. Before you
start working with files get familiarized with the basic notions.

Measurement file

File containing measurement data (e.g., MDF). Measurement files fall into two categories: signal-based and
message-based ones.

Signal-based measurement

A typical format of signal-based files is MDF. In this format, only signals (temporal progressions of values),
not CAN message or similar raw data from the communication protocols in a vehicle, can be stored. These
formats are easy to handle and read. However, data loggers usually record messages from which signals must
first be extracted. During the process of converting messages into signals, some information, such as signals
that are not taken into account or additional information from the communication protocol (e.g. Controller
Area Network (CAN) error), can be lost.

Message-based measurement

Message-based data formats store received data frames. If the measurements represent signals over time,
some additional information —descriptions (e.g. in the form of database CAN (dbc) files) —is needed. Typical
message-based formats are Vector ASCIl (ASC) and Vector BLF (BLF). Most raw data formats also fall into
this category.

Data description

Data description formats are such file format that do not contain data in the actual sense but only format
descriptions. For example, DBC format contains the descriptions of those CAN message, bit position and
form that a certain signal value had when transmitted. Such data is needed to display a signal representation
for message-based measurements. When opening a message-based file, IAV Merida Signals automatically
asks for a data description.

Platform

A platform is treated as a set of several data description files together with the assignments to physical
channels of the data loggers.

4.2 Open and view signal-based measurements

Operating signal-based measurements is relatively simple and it allows the following:

= Opening a measurement file
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= Opening a measurement file with a signal list

= Importing and exporting a signal list

= Adding a measurement file

Opening a measurement file

To open a measurement file, you can use two ways: through Merida Signals interface and through Windows

Explorer.
To open a measurement file using Merida Signals interface, follow the steps below:

1. Press Open in the File menu.
- Alternatively, you can open a measurement file by pressing the far-left folder icon in
the Toolbar.

2. Select the desired measurement file.

3. Click OK to confirm.

After confirming, all available signals in the file will be listed on the Signal list area of the

Main window.

To open a measurement file using Windows Explorer, follow the steps below:

1. Find the desired measurement file in File Explorer on your computer.

2. Double-click a file and press Open.

- Alternatively, you can open a measurement file by using Send to (right-click a file and
select Merida Signals) in the Explorer context menu or dragging and dropping a file to the

Plot panel.

NOTE
This method of opening applies to most file formats. However, some formats can only be

opened from within Merida Signals.

Opening a measurement file with a signal list

If a measurement is extremely large, not all signal values can be loaded into computer memory. In such a
case, only certain signals from the file can be read. For this purpose, several functions exist.

To open a measurement file with a signal list, follow the steps below:
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1. Press Open file with signal list in the File menu.

- Alternatively, you can press the folder icon E‘; in the Toolbar or use Send to (right-click
a file and select IAV Merida Signals 2 - Signalauswahl) in the Explorer context menu.

2. Select the desired measurement file.

3. Click OK to confirm.

After that all signals present in the file are displayed in the Signal selection window (see Figure
6). Here you can select signals that should be shown, by ticking a box.

@ signal selection X

Signal
PID
UTCTime
abc_CAP_L
Iv_cdn_diag_CAP_L
Iv_cdn_diag_cap,_|
n
posn_bpa_0
posn_sp_bpa_0
prs_up_thr
prs_up_thr_sp
psn_rcl_sp

put_min_cap_|_diag_lim

O0000o0oOoo0o0ooooo

py_av
) t_diy_cap_|_diag
] teo

[ tps_av

[ vs

cancel | import signallist | Export signallist | Load

Figure 6: The Signal selection window

4. Select signals from the signals list and press Load.

After loading, the corresponding signals are read from the file and will be listed in the Signal
list area of the Main window.

Importing and exporting a signal list

In the Signal selection window (see Figure 6), it is also possible to import and export a signal list. These
two functions allow storing the selection of signals in order to reuse the same selection later.

To import a signal list, follow the steps below:

1. Press Import signal list.

2. Select the appropriate file from your computer and click it.

After the signals are imported, they are displayed in the signal list as ticked ones.

To export a signal list, follow the steps below:
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Select the desired signals by ticking boxes next to them.
Press Export signal list.
Save the file.

CAUTION
If no signal is selected, the exported file will be empty.

\

NOTE
A list of signals can also be exported using the ‘Export signals as a list’ option found in the
Signal menu. For more information see Exporting signals as a list.

Adding a measurement file

When one measurement is already opened, you can add the signals from another second measurement file.

To add a measurement file, follow the steps below:

Press Open and add in the File menu.

- Alternatively, you can press the third folder icon [[=1 on the left-hand side in the Toolbar.

Select and open the desired file from your computer.

After the second file has been added, the names of the signals from the added file are suffixed
with a dot followed by the file name. So that they can be reliably distinguished from the
signals in the previously opened file.

\

NOTE
Using these options of adding a measurement file presupposes that you have to select signals
while opening.

4.3 Open and view message-based measurements

Operating with message-based measurements is slightly different from working with signal-based measure-
ments. In order to open message-based measurements, data descriptions (e.g., DBC-files) are needed. All
data descriptions together with their assignment to physical channels are referred to as platform.

With the help of Merida Signals, the following is possible:

= Opening a message-based file

= Displaying messages with signals
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Opening a message-based file

To open a message-based file, follow the steps below:

1. Open a measurement file (see Opening a measurement file).

2. Select an appropriate platform in the Platform dialog window.

When a measurement file containing messages is opened, the Platform dialog window opens
automatically (see Figure 7).

8 Platform dialog

~ Plattforms

> ﬁ Platform 1
> ﬁ Platform 2
> ﬁ Platform 3
gz Platform 4
Figure 7: The Platform dialog window
CAUTION

Make sure that a platform is set up (e.g. data descriptions are added) and an
appropriate platform is selected (see Configuring a platform to learn how to
set up platforms).

NOTE

% The Platform dialog box can be skipped with the Skip button (see Figure 7).
In this case, only the signals which can be read in the signal form directly from
the file will be loaded. In many cases, however, nothing is read afterwards.

3. Click OK to confirm.

After confirming, all the signals present in the file are displayed in the Signal list area of the
Main window.

Displaying messages with signals

To display messages with signals, follow the below steps:
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1. Go to the File menu.

2. Deactivate Load signals only.
3. Open a measurement file (see Opening a measurement file).
CAUTION

The display of messages in this case will require much more memory, which can lead to
impossibility to open some extensive measurements.

NOTE
% Alternatively, a series of consecutive messages can be viewed in the Trace window (see
5.4 Trace window).

4.3.1 Operating with platforms

You can set up a platform through the Platform dialog window. This window can be accessed either
automatically upon opening a measurement file with messages or manually by pressing the P key on your
keyboard.

In the Platform dialog window, the following is possible:

= Creating a new platform

= Configuring a platform

= Decoding file with AUTOSAR

= Modifying signal and channel names

= Editing a channel

= Renaming a platform

= Exporting and importing platform settings

= Deleting a platform, channel

Creating a new platform

To create a new platform, follow the steps below:

1. Right-click on the top line ‘Platform’ .

2. Select New platform.
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3. Enter a platform name in the opened window and press Save.

After saving, a new platform will appear in the platform list.

Configuring a platform

To configure a platform, follow the steps below:

1. Right-click on the ‘Platform’ node.
2. Select New decoder from the option list.

3. Select an appropriate decoder for your measurement file.

The following formats are supported:

= DBC

= LDF

= FIBEX

= MOST Catalog

= AUTOSAR Catalog

Once a decoder has been selected, a corresponding window (see Figure 8) will open where
data descriptions and related channels must be added.

@ canpec b3

Channel 1

<

File

Name
Attach ID
Add name

Use SignalLongName

Cancel ok

Figure 8: Decoding CAN-DBC

4. Fill out the data (data descriptions, channels, etc.) in accordance with the requirements of
the chosen decoder.

NOTE
% When decoding a CAN measurement file with a DBC file format, several op-
tions below the Name field can be used for the signal names.

The following is possible:

= Add name —to add message name to the signal names.

= Attach ID —to add message ID to the signal names.
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= UseSignalLongName —to avoid the limitations on the length of the signal names for
DBC files supporting that option.

5. Click OK to confirm.

After confirming, a channel will be displayed under the platform name. In such a way, a
platform can be assigned any number of data descriptions.

CAUTION
To decode a file with AUTOSAR, the file with data descriptions is yet to be decoded (see
Decoding file with AUTOSAR).

Decoding file with AUTOSAR

To decode a file with AUTOSAR, follow the steps below:

1. Right-click on the ‘Platform’ node.

2. Select New decoder from the option list.

3. Select AUTOSAR in the New decoder.

4. Add a data description file in ARXML format in the opened window.

5. Click OK to confirm.

After confirming, the file appears in the Platform dialog window with a network symbol (see
Figure 9).

8 Platform dialog x

~ Plattforms
? ﬁ Platform 1
> ﬁ Platform 2
> ﬁ Platform 3
% f; Platform 4
% AUTOSAR: sample.ar<ml

Figure 9: Decoding file with AUTOSAR

6. Right-click on the AUTOSAR file and select the decoder.

7. Continue settings in accordance with the requirements of the chosen bus system.
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CAUTION

= With Ethernet decoder you have to choose a cluster, number of channels and the
channel number for each VLAN (separated by commas) if ‘Multi channel’ is chosen.

= Physical channel is used on the recording device.

Modifying signal and channel names

In order to distinguish which signals come from which bus (e.g. CAN), you can edit the name of the channel,

which is reflected in the names of all signals (see Figure 8).

To modify signal and channel names, follow the steps below:
1. Right-click on the configured channel in the Platform dialog window and select Edit.
2. Enter a name in the Name field.

3. Click OK to confirm.

After confirming, the name is displayed both behind the channel number in the platform
configuration and in front of the signal name, being separated by a dot.

NOTE
% Signal and channel names can also be modified when decoding a measurement file (see
Configuring a platform).

Editing a channel

To edit a channel, follow the steps below:

1. Right-click on the channel.
2. Select Edit.
3. Edit the desired data.

4. Confirm with OK to save the changes.

Renaming a platform

To rename a platform, follow the steps below:
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Right-click on the ‘Platform’ node.
Select Rename.
Enter a new platform name in the opened window.

Click OK to save the changes.

After saving, a new name for a platform is displayed.

Exporting and importing platform settings

When operating with message-based measurements, it is essential to set up a platform that allows you
to access the measurement file (see Configuring a platform). Once this setup is complete, Merida Signals
provides the possibility to export the platform’s settings in an XML file. This XML file can be used later,

for instance, to conveniently share the platform settings or retrieve measurements in case the platform is

accidentally deleted.

To export platform settings, follow the steps below:

1.
2.
3.
4.

Open the Platform dialog window by pressing P key.
Right-click on the Platform node and select XML-export.
Enter a file name.

Click Save to complete the saving.

To import platform settings, follow the steps below:

1.
2.

Open the Platform dialog window by pressing P key.
Right-click on the top line ‘Platform’
Select XML-import.

Open an XML file with configured platform settings.

After an XML file is opened, a platform will appear at the end of the platform list.

CAUTION

When importing your XML file, there may be a request to include a data description file.
This can happen if the exported platform is not fully configured or if a data description file
related to the exported platform has been removed. In such cases, it is advisable to store
all the files (the XML file with configured platform settings and the corresponding data
description files) in the same folder to maintain the same file path.

Deleting a platform, channel

To delete a platform or channel, follow the steps below:
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1. Right-click on the Platform node or Channel, depending on which one you want to delete.

2. Press Delete.

3. Press Yes in the opened window to confirm the deletion.

4.4 Comment on the file and other metadata

For a measurement file, you can view and edit its metadata that includes the file comment and other relevant
information. This data may include details about file's creation date, organization, project affiliation, etc.

With file information, the following is possible:

= Viewing and editing a file’ s metadata

Viewing and editing a file’ s metadata

To view or edit a file’ s metadata, follow the steps below:

1. Open the Signal menu.

2. Press Display comment.

After the option is pressed, the Comment window is displayed (see Figure 10).

@ comment x
A T 1
c o
Figure 10: The Comment window
3. View and/or edit information.
CAUTION

You cannot remove the date of a file creation, and any attempt to do so will
result in an error message.

4. Confirm with OK to save the changes or to close the window.

4.5 Warnings about errors

If a measurement file contains non-crucial errors (e.g. incorrect signals display), they can be ignored by IAV
Merida Signals file readers when opening a file. However, they are recorded in a log.

The logging function allows the following:
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= Viewing the warnings list

= Clearing the warnings list

Viewing the warnings list

To view the warning list, follow the steps below:

1. Open the File menu.

2. Select Warnings.

After Warnings is selected, the Warnings window with all recorded errors will be displayed.

Clearing the warnings list

To clear the warnings list, follow the steps below:

1. Open the File menu.
2. Select Warnings.

3. Press Clear.

After it is done, all logged errors will be removed.
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5 Operating with signals

IAV Merida Signals provides various options for operating with signals. In this section, you can learn how to

use them.

5.1 Representing signals

When a measurement file is open, you can use various functions to set up the representation of signals.

To represent signals, the following actions can be performed:

Displaying signals on the Plot panel

Removing signals from the Plot panel

Removing signals with a constant value from the Plot panel

Searching for signals

Changing the view of the signal list

Adding and removing additional information on signals

Showing and hiding additional information on signals

Displaying signals on the Plot panel

After the requested signals are retrieved, they can be displayed on the Plot panel.

To display signals on the Plot panel, follow the steps below:

1. Go to the Signal list area.

2. Select signals that should be shown.

\

NOTE

Like in other programs, multiple signals can be selected using the Ctrl (indi-
vidually) or the Shift (for a series of consecutive signals) buttons. To select
all the signals, first click on any signal in the Signal list area and then press
Ctrl4-A.

3. Drag and drop them from the signal list into the Plot panel.

Alternatively, the signals can be displayed on the Plot panel by following the steps below:

1.
2.

Right-click on the Signals list area.

Press Display signals.

IAV Merida Signals = 2.2605.1584346 = 05/18/2026 25



Removing signals from the Plot panel

To remove signals from the Plot panel, follow the steps below:

1. Select signals in the Signal list area.
2. Right-click in the Signal list area.

3. Press Hide.

Alternatively, you can remove signals from the Plot panel by following the steps below:

1.  Go to the Signal list area.
2. Select signals that should be removed.

3. Press Hide in the Signal list area or Remove in the Signal menu or use Delete
key.

Removing signals with a constant value from the Plot panel

To remove signals with constant value, follow the steps below:

1. Go to the Signal list area.
2. Do one of the following:

= Press Delete constant in the Signal menu to remove all signals with a constant value.

= Press Delete constant in window in the Signal menu to remove all signals with a
constant value in the displayed area.

Searching for signals

When there are too many signals in a measurement, you can use the search function. AV Merida Signals
provides two options with the search —basic and with regular expressions.

To search for signals, follow the steps below:

1. Go to the Signal menu.
2. Do one of the following:

= Press Search or F1 keyboard shortcut to use basic search.

= Press Search with RegEx or F11 keyboard shortcut to use search with regular expres-
sions.

After the search method is chosen, the Signals search window opens (see Figure 11).
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Figure 11: The Signals search window

3. Enter a keyword (name or unit of the signal to be searched for).

NOTE

The operators ~ and $ in regular expressions are used to indicate whether
the search text starts or ends, respectively, the expression (e.g., the request
““start.*end$’ initiates a search of signals the names of which start with ‘start’
and end with ‘end’ ). Make sure that before asterisk symbol * a dot is added.
Therefore, signals can be searched with the help of operators used to specify
beginnings and endings of signal names. If these operators are not used, the

expression can match signals that contain the specified text at any position.

4. Click Enter key to confirm.

After confirming, the signal list is updated so that only the signals included into the search
are displayed.

NOTE
To add all signals in the search results to the Plot panel, click All. To add the
individual signals to the Plot panel, follow the steps below:

1. Hold down Shift key.
2. Select signals.

3. Click OK to confirm.

Adding and removing additional information on signals
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An additional information about signal parameters (e.g. channel ID, message ID, VLAN, etc.) can be added
or removed in the signal names. The type of this information depends on the measurement file and format
of data description.

To add and remove additional parameters in the signal names, follow the steps below:

1. Go to the Signal menu.
2. Hover the mouse cursor over Select extended info.
3. Click on the desired parameters in the opened list to add/remove them.

Showing and hiding additional information on signals

To show or hide all additional parameters in the signal names, use CRTL+1 keyboard shortcut or follow the
steps below:

1. Go to the Signal menu.

2. Press Toggle extended info.

NOTE
The Toggle extended info function is activated by default.

5.2 Projects

Projects can be used to store information which is not part of the measurement itself. This includes the
definition of virtual signals (see Virtual signals) as well as frame signals (see Frame signals). Projects are
opened and saved separately from measurements. This means, if a project is already open when a new
measurement is loaded, the virtual signals and frame signals are updated with the data from the new
measurement. If a measurement is already open when a project is loaded, the virtual signals and frame
signals from the project are applied to the measurement. | a project ist opened shile no measurement is
open, all signals remain empty.

The following actions can be performed with projects:
= Creating a project
= Opening a project

= Saving changes to a project

Creating a project

To create a project with your virtual signals, follow the steps below:

1. Create something you want to reuse (e.g. virtual signals (see Creating a new virtual signal)).

IAV Merida Signals = 2.2605.1584346 = 05/18/2026 28



2. Press Save Project as in the File menu.

3. Select the storage of your project and provide your file with a name.

4. Click Save to confirm.

Opening a project

To open a project with your virtual signals, follow the steps below:
1. Press Open Project in the File menu.
2. Select the file with your project.
3. Click OK to confirm.

CAUTION
In the case when you open a project without having started a relevant measurement file you

might be alarmed with a warning message (e.g. that a virtual signal cannot be rendered).
Close the warning message, open a measurement file (see Opening a measurement file) and

continue with your project.

Saving changes to a project

To overwrite a project after introducing some changes, follow the steps below:

1. Make the desired changes (see e.g. Editing a virtual signal).

2. Press Save Project in the File menu.

3. Click OK to confirm.

5.3 Signal groups

In the left part of the Main window, besides signal list, there is the area with signal groups. The following

signal groups exist by default:

All Signals —all signals related to the measurement are displayed

Visible Signals —all signals added to the Plot panel (see Displaying signals on the Plot panel)

Virtual Signals —all signals artificially generated by user, using mathematical models are displayed (see

Virtual signals)

= Frame Signals —signals containing raw frame data and defined by frame filters (see Frame signals)

The following actions can be performed:
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= Switching between signal groups

= Adding, removing or editing custom signal groups

Switching between signal groups

To switch the group of signals, press M key or follow the steps below:

1. Go to the Signal groups area of the Main window.

Signal groups

Figure 12: The Signal groups area

2. Select the desired group by clicking on it.

Alternatively, you can switch between the signal groups using the Switch list option in the

Signal menu.

NOTE
% You can change the size of the ‘Signal groups' area by clicking on the title bar and dragging
it to the desired position upwards and downwards.

5.3.1 Custom signal groups

Signal groups are sets of signals which can be used to organize signals for convenience. Signal groups are
stored and loaded together with the project, thus they can be reused in other measurements.

The following actions can be performed:

= Creating a new signal group

= Editing a signal group

= Deleting a signal group
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Creating a new signal group

To create a new signal group, follow the steps below:

Go to the Signal groups area.

Right-click on the area and then select New signal group.

In the window that opens (see Figure 13), provide the name of the group.

Add the corresponding signals by selecting them in the left signal list and pressing the right

arrow key.

Remove signals by selecting them in the right signal list and pressing the left arrow key.

Click OK to confirm.

Available signals Selected signals

»
«

Figure 13: The signal groups window

To edit a signal group, follow the steps below:

Go to the Signal groups area.
Select a signal group you want to edit.

Right-click on it and then select Edit.

In the window that opens (see Figure 13), make the desired changes.

Click OK to confirm.

CAUTION

To keep your signal groups for further usage, save them as a project. When you load the

project in a later session, these virtual signals will be restored.

If you make changes to a project, the changes are not going to be automatically saved. You

have to save them manually (see Saving changes to a project)

Deleting a signal group

To delete a signal group, follow the steps below:

1.

Go to the Signal groups area.
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2. Select a signal group you want to delete.
3. Right-click on the signal group and then select Delete.

4. Click Yes to confirm.

5.3.2 Virtual signals

Virtual signals refer to artificially generated signals that replace or mimic the original signals coming from
measuring devices (data loggers) in a vehicle. Virtual signals are simulated by means of changing the original
signals with the help of mathematical expressions.

IAV Merida Signals treats a combination of settings that specify virtual signals as ‘project’ . A project can
be applied to different measurements.

The following actions can be performed:

= Creating a new virtual signal

= Editing a virtual signal

= Deleting a virtual signal

Creating a new virtual signal

To create a new virtual signal, follow the steps below:

1. Go to the Signal groups area.
2. Right-click on the area and then select New virtual signal.
3. In the window that opens, provide the name, unit and expression for your virtual signal. When

you start typing in the Expression field, the list of signals available in your measurement file
is displayed for you to choose from.

4. Click OK to confirm.

Expression i

Cancel

Figure 14: The Virtual Signals window
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% NOTE

= The Info icon , when clicked, provides the list of possible functions that you can
apply to signals and their descriptions.

= You can either enter the function you want to apply manually or drag it to the
Expression field from the list displayed when the Info icon is clicked on.

= The Expression field can contain complex expressions using several functions and
operators simultaneously.

= In the descriptions of some functions additional parameters are mentioned. These can
be configured by adding comma-separated expressions in the form "parametername
-> value” to the argument list of the function (e.g. filter(1, 10, 2, signal, type ->
'butterworth,hp’))

Editing a virtual signal

To edit a virtual signal, follow the steps below:

1.

2.

Go to the Signal groups area and select Virtual Signals.

Select a signal you want to edit.

Right-click on a signal and then select Edit.

In the window that opens (see Figure 14), make the desired changes.

Click OK to confirm.

CAUTION

To keep your virtual signals for further usage, save them as a project. When you load the
project in a later session, these virtual signals will be restored.

If you make changes to a project, the changes are not going to be automatically saved. You
have to save them manually (see Saving changes to a project)

Deleting a virtual signal

To delete a virtual signal, follow the steps below:

1.

2.

Go to the Signal groups area and select Virtual Signals.
Select a signal you want to delete.
Right-click on a signal and then select Delete.

Click OK to confirm.
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5.3.3 Frame signals

Frame signals refer to raw frame data read from measurement files. Not all measurement files contain frame

based data.

Frame signals are defined by frame filters for corresponding types of frames (e.g. CAN frames).

The following actions can be performed:

= Creating a new CAN signal

= Creating a new ethernet signal

= Creating a new SOME/IP signal

= Editing a frame signal

= Deleting a frame signal

= Updating the frame signals

CAUTION

The frame signals are rendered, when a project is loaded, a measurement is loaded or the
signals are updated (see 5.3.3).

They are not updated immediately after they are created or edited.

Creating a new CAN signal

To create a new CAN signal, follow the steps below:

1. Go to the Signal groups area.
2. Right-click on the area and then select New CAN signal.
3. In the window that opens, provide the name and filter criteria vor the CAN signal.

4. Click OK to confirm.

Input signals All matching frame signals (no signals in measurement

Channels 13,9

Message IDs | 0x200-0x203, 100, Ox17330Ax

Figure 15: The CAN signals window
The following filter critera can be used for CAN signals:
1. One or more input signals can be selected in a list. If no signal is selected, the filter will be

applied to all available CAN signals. Otherwise only the selected signals will be used.
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2. The frames can be filtered by channel numbers. If the channels field is left empty, all channels
are considered. Otherwise a comma-separated list of channels and channel areas is expected
(see Figure 15).

3. The frames can be filtered by IDs. If the message IDs field is left empty, all frames from the
selected channels considered are considered. Otherwise a comma-separated list of IDs or ID

areas is expected (see Figure 15). IDs can be given in decimal or hexadecimal form. Extended
IDs are suffixed with an x.

Creating a new ethernet signal

To create a new ethernet signal, follow the steps below:

1. Go to the Signal groups area.
2. Right-click on the area and then select New ethernet signal.
3. In the window that opens, provide the name and filter criteria vor the ethernet signal.

4. Click OK to confirm.

Signal name | ethFiter
Input signals  All matching frame signals (no signals in measurement)
Channels 135

VLans 12

Ports 12345

1P addresses | 2001:db8:3c4d:15::0/64

Figure 16: The ethernet signals window
The following filter critera can be used for ethernet signals:
1. One or more input signals can be selected in a list. If no signal is selected, the filter will be
applied to all available CAN signals. Otherwise only the selected signals will be used.

2. The frames can be filtered by channel numbers. If the channels fiels is left empty, all channels
are considered. Otherwise a comma-separated list of channels and channel areas is expected
(see Figure 17).

3. The frames can be filtered by VLANSs. If the channels field is left empty, all channels are
considered. Otherwise a comma-separated list of channels and channel areas is expected (see
Figure 17).

4. The frames can be filtered by TCP/UDP ports. If the ports field is left empty, all ports are
considered. Otherwise a comma-separated list of ports and port areas is expected (see Figure
17). All ports and addresses are considered for source AND destination.

5. The frames can be filtered by IP (v4/v6) addresses or subnets. If the IP addresses field is left
empty, all addresses are considered (see the following examples).

(a) 192.168.0.1 (simple IPv4 address)
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(b) 192.168.0.0/16 (subnet 192.168.x.x (first 16 bit))

(c) 192.168.0.1/255.255.0.255 (subnet 192.168.x.x but only addresses with 1 in the last
part)

(d) 2001:db8::0 (simple IPv6 address, the :: stands for as many zeros as needed for a
complete address and can only be used once)

(e) 2001:db8::0/32 (subnet starting with 2001:db8 (first 32 bit))

(f) 2001:db8::1/fffffFff::ffff (subnet starting with 2001:db8 but only addresses with 1 in the
last part)

6. The frames can be filtered by MAC addresses. If the MAC addresses field is left empty, all
addresses are considered. Otherwise a comma-separated list of MAC addresses is expected.

Creating a new SOME/IP signal

SOME/IP signals are frame signals containing SOME/IP data. They are further divided into Service Discovery
(SD) signals, Service signals and Individual signals. SD signals contain information about offered services
and corresponding service subscriptions. Service signals contain the payload data for one specific service. If
they are created using the corresponding ARXML descriptions, the payload data is also interpreted into a
human readable (JSON) form. The content of the SOME/IP signals is shown in the cursor window and the
trace window.

If an ARXML description exists, it is also possible to extract individual signals from the corresponding service.
This case is described in 5.3.4.

To create a new SOME/IP signal, follow the steps below:
1. Go to the Signal groups area.

2. Right-click on the area and then select New SOME/IP signal and the type of SOME/IP
signal you want to create.

3. In the window that opens, provide the name and filter criteria vor the SOME/IP signal.
Depending on the type of signal some parameters from figure 17 might not occur.

4. Click OK to confirm.

@ soverp-signs x
AR

Sgnalname | signal

nput signals Al matching frame signals (no signals in messurement]

Channels

Ports 50490, 30491, 30501-30504, 34502

Method D

Method Name

Figure 17: The SOME/IP signals window

For SOME/IP signals all filters from the ethernet signals can be applied. The filters must be chosen so
that only SOME/IP frames pass. The default value for the port filter contains the ports usually used for
SOME/IP communication. Other ports can be added for custom services. In addition the following filters
and parameters can be set, depending on the type of SOME/IP signal:
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1. The ARXML file (only for service signals with ARXML) is needed for the interpretatin of data
and the service and method names. Multiple files can be selected if the service description is
derived over multiple ARXML files.

2. The service ID of the service (only for service signals).

3. The service name of the service (only for service signals with ARXML). ID and name are
equivalent, thus, only one of both has to be selected.

4. The method ID of the service (only for service signals).

5. The method name of the service (only for service signals with ARXML). ID and name are
equivalent, thus, only one of both has to be selected.

Editing a frame signal

To edit a frame signal, follow the steps below:

1. Go to the Signal groups area and select Frame Signals.
2. Select a signal you want to edit.

3. Right-click on a signal and then select Edit.

4. In the window that opens, make the desired changes.

5. Click OK to confirm.

Deleting a frame signal

To delete a frame signal, follow the steps below:

1. Go to the Signal groups area and select Frame Signals.

2. Select a signal you want to delete.

3. Right-click on the signal and then select Delete.
CAUTION

To keep your frame signals for further usage, save them as a project. When you load the
project in a later session, these frame signals will be restored.
If you make changes to a project, the changes are not going to be automatically saved. You
have to save them manually (see Saving changes to a project)

Updating the frame signals

Frame signals are not rendered immediately after they are edited or created. The reason is that the measure-
ment file is read from disk every time the signals are updated. Thus it is preferable to first create all signals
needed and update the data afterwards. To update the frame signals, follow the steps below:
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2.

Go to the Signal groups area.

Right-click on Frame signals and then select Update frame signals.

5.3.4 SOME/IP individual signals

For SOME/IP services with a corresponding service description in form of an ARXML file, it is possible to
extract individual values from the SOME/IP payload as signals. The signals are in this case added to a new

signal group and can be plotted like other signals.

To create a signal group with signals from the SOME/IP payload, follow the steps below:

1.

2.

Go to the Signal groups area.
Right-click on the area and then select New SOME/IP signal and Individual signals.

In the window that opens, provide the name for the signal group to be created and filter
criteria for the SOME/IP service. The parameters here correspond to the dialog for SOME/IP
services with ARXML (5.3.3).

Click OK to confirm.

On the second page of the dialog (see Figure 18) select the values you want to be extracted
as signals in the tree structure on the left.

Use the arrow keys in the middle to add the selected signals to the signal group or remove
incorrectly added signals.

Click OK to confirm.

BBBBBB

Figure 18: Selection of signals from SOME/IP payload

After confimation a new signal group with the selected name is created. The new signal group contains one

signal for each selected value. The signal names are generated from the full path of the value in the structure
of the payload from the SOME/IP frame.

CAUTION

Like frame signals these signals are rendered, when a project is loaded, a measurement is
loaded or the signals are updated (see 5.3.3).

They are not updated immediately after they are created or edited.
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5.4 Signal colour settings

While working with signals, the following is possible:

= Changing the colour of selected signals

= Recolouring visible signals

Changing the colour of selected signals

To change a colour of the selected signals, follow the steps below:

1. Select signals (one, several or all) whose colour is to be changed.
2. Press Colour in the Signal menu or use F key.
3. In the opened window (the New colour window, see Figure 19), select the desired colour.

Various colours can be found in Swatches and modified in HSV, HSL, RGB, and CMYK colour

models.

B ew colour x

Swatthes | HSV | HSL | RGB | CMYK | Scheme

Figure 19: The New colour window
4. Click OK to confirm.

CAUTION
If no signal is selected, the Colour option will be unavailable.

Recolouring visible signals

To recolour visible signals, follow the steps below:

1. Go to the Signal menu.

2. Press Recolour visible signals.

Once the process is completed, the visible signal colours will be automatically adjusted to the
colours of the current colour scheme (see Colour scheme, to learn how to view and configure

the colour scheme).
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5.5 Signal information

The information on signals from the opened file can be viewed for an individual signal, a set of chosen signals,
and for all signals. It should be noted that the specific signal information may vary depending on the file

format.

The following is possible:

= Viewing signal information

Viewing signal information
To view signal information, press | key or follow the steps below:

1. Select a signal or signals whose information you would like to view.

2. Press Info in the Signal menu.

Once it is done, the Signal info window containing comprehensive details about the signals
will be displayed (see Figure 20).

e air pressure LOW diagnosis after exceeding PQ_CHA_SP_MIN condition

e air pressure LOW diagnosis after exceeding PQ_CHA_SP_MIN condition

Figure 20: The Signal info window

CAUTION
If no signal is selected, the number of all signals and points of these signals are displayed.

5.6 Trace window

As an alternative way of displaying signals, the Trace window can be used.

The following is possible:

= Viewing signals in the Trace window

= Copying data of signal values in the Trace window
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= Viewing format of frame-based signals

Viewing signals in the Trace window

To view the signals in the Trace window, press T key or follow the steps below:

1. Press Trace window in the Signal menu.

After it is done, the Trace window will be displayed (see Figure 21).

Figure 21: The Trace window

- Alternatively, you can open the Trace window by right-clicking on the Plot panel and
selecting Trace window in the Signal sub-menu.

2. Drag the signals from the signals list to the Trace window.

NOTE
% It is recommended to use the Trace window when frame signals, such as CAN frames, are
to be displayed.

Copying data of signal values in the Trace window

Using the Trace window, you can copy data of signal values displayed in the window. Merida Signals provides
several options to copy signals data depending on the signals type:

= Basic copying data of the signal values for all signal types

= Copying data in ASC format for frame-based signals

To copy data of signal values in a basic way, follow the steps below:

1. Hover the mouse cursor over the column cell in the Trace window.

2. Right-click on the column cell.
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3. Press Copy.

To copy data of frame-based signals in ASC format, follow the steps below:
1. Hover the mouse cursor over the column cell in the Trace window.
2. Right-click on the column cell.

3. Press Copy in ASC format.

NOTE
If you want to copy data of several signal values, press CTRL to select individual signals in
different location of the Trace window or Shift+A to select all signals.

Viewing format of frame-based signals

While operating with frame-based signals, it is possible to make the information on this type of signals more

readable.

To view the format of signal values, follow the steps below:

1. Hover the mouse cursor over the column cell in the Cursor window.
2. Right-click on the column cell.
3. Press Format view.

CAUTION

By default, the Format view option is activated. If there is a need to view the format of
the signal values as it is, the option should be deactivated.

5.7 Interpretations

Many signals have a physical interpretation alongside the raw data interpretation. When the signal has
several interpretations, it is possible to select one of them.

The following is possible:

= Selecting interpretation

Selecting interpretation

To select interpretation, follow the steps below:
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1. Select a signal in the Signal list area.

2. Press Interpretation in the Signal menu.
- Alternatively, you can right-click on the Plot panel and hover the mouse cursor over Signal.

3. Press Interpretation.

A small window will open where the appropriate interpretation can be selected.
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6 Cursors

IAV Merida Signals provides the usage of a cursor. Cursors play a crucial role in obtaining more accurate
information at specific time points.

6.1 Using cursors

When operating with cursors, the following is possible:

= Viewing signal values with Single cursor

= Viewing signal values with Double cursor

= Sorting signal values in the Cursor window

= Copying data of signal values in the Cursor window

= Viewing format of frame-based signals

Viewing signal values with Single cursor

To view signal values with Single cursor, press Period key or follow the steps below:

1 Press the left button - in the Toolbar to activate the cursor.

- Alternatively, you can activate the cursor by right-clicking on the Plot panel and pressing
Cursor.

After activation, the signal values of all the signals which are located at the position of the
cursor will be shown in the Cursor window (see Figure 22).

‘@ Ccurser X ‘

Name Value Text value

Figure 22: The Cursor window, Single cursor is activated

The cursor position is represented by a vertical white line.

2. Hover the mouse cursor over the white line and drag it to the new position to view the desired
signal values.

Viewing signal values with Double cursor

To view signal values with Double cursor, press Comma key or follow the steps below:

1. Press the right button |} in the Toolbar to activate the cursor.

- Alternatively, you can activate the cursor by right-clicking on the Plot panel and pressing
Two cursors.
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After activation, the difference in time and signals between the two cursor positions, as well
as the values at both cursor positions and the minimum and maximum values between the
cursor positions, are displayed in the Cursor window (see Figure 23).

Figure 23: The Cursor window, Double cursor is activated

The positions of two cursors are represented by vertical white lines.

2. Hover the mouse cursor over the white line and drag cursors to the new positions to view the
difference in time and signals between them.

Sorting signal values in the Cursor window

All signal values presented in the Cursor window, upon cursor activation, can be sorted in ascending or
descending order.

To sort signal values in the Cursor window, follow the steps below:

1. Hover the mouse cursor over the column header in the Cursor window.
2. Press the corresponding header.
3. Repeat the previous steps to cycle through ascending, descending and default order.

The default order of the signals in the cursor window is the same as the order in the plot. It can be changed
by moving the plotted signals to desired position.

Copying data of signal values in the Cursor window

Using the Cursor window, you can copy data of measurement values displayed in the window. Merida Signals
provides several options to copy measurement data depending on the signals type:

= Basic copying data of the signal values for all signal types

= Copying data in ASC format for frame-based signals

To copy data of signal values in a basic way, follow the steps below:

1. Hover the mouse cursor over the column cell in the Cursor window.
2. Right-click on the column cell.

3. Press Copy.

To copy data of frame-based signals in ASC format, follow the steps below:
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1. Hover the mouse cursor over the column cell in the Cursor window.
2. Right-click on the column cell.

3. Press in ASC format.

NOTE

= |f you want to copy data of several signal values, press CTRL to select individual
signals located at different positions within the Cursor window or Shift+A to select
all signals.

= Data of signal values can be also copied in the Trace window (see 5.4 Trace window).

Viewing format of frame-based signals

While operating with frame-based signals, it is possible to make the information on this type of signals more
readable.

To view the format of signal values, follow the steps below:

1. Hover the mouse cursor over the column cell in the Cursor window.
2. Right-click on the column cell.
3. Press Format view.

CAUTION

By default, the Format view option is activated. If there is a need to view the format of
the signal values as it is, the option should be deactivated.

6.2 Notes on the signal

IAV Merida Signals allows you to leave notes on the signals. When some signals are selected, you can add
notes to them.

When operating with notes, the following is possible:

= Adding a note

= Showing and hiding notes

= Removing a note
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Adding a note

To add a note, use CRTL+H keyboard shortcut or follow the steps below:

1. Activate the cursor (see Using cursors).

2. Select a signal.

CAUTION
If no signal is selected, the note will be linked to the point with the nearest

signal value.

3. Go to the Signal menu and hover the mouse cursor over Note.

- Alternatively, you can right-click on the Plot panel, select Signal and hover the mouse

cursor over Note.

4. Press Add in the Note sub-menu.
After it is done, the Add note window will be displayed (see Figure 24).

@ signal: temperature_up_thr X
Text: | temperature_up_thr [*C] = 436.254

Cancel Ok

Figure 24: The Add note window

NOTE

By default, signal name and value are shown in the field which correspond to
the signal position. Some signals have both a numeric and a textual display.
In such a case, both the signal value in numerical form, and the signal value
in the textual form are displayed. The text display will then be enclosed in

square brackets.

5. Enter your notes in the Text field.

6. Click OK to confirm.

After confirming, a note will be displayed on the Plot panel. The location of the note is
determined by the type of cursor that is active. If the Single cursor is activated, the note will
be linked to the nearest signal value. On the other hand, when Two cursors are activated, a
note will be created between them and linked to the nearest signal values using two lines. In
this way, it is possible, for example, to mark the range of the signal curve.

Showing and hiding notes

To show or hide notes, press A key or follow the steps below:
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Go to the Signal menu and hover the mouse cursor over Note.

- Alternatively, you can right-click on the Plot panel, select Signal and hover the mouse
cursor over Note.

Press Display notes in the Note sub-menu.

Removing a note

To remove a note, follow the steps below:

1.

Activate Single or Double cursor (see Using cursors).
Select signal the note on which you would like to remove.

Go to the Signal menu and hover the mouse cursor over Note.

- Alternatively, you can right-click on the Plot panel, select Signal and hover the mouse
cursor over Note.

Press Remove.

CAUTION

Before calling the Remove option, the cursor must be placed in close proximity to the
corresponding signal value. If the note has been added with a double cursor, it can only be
removed with both cursors being placed in close proximity.
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7 Scaling configuration

7.1 Axes arrangement and scaling

When the signals are displayed for the first time, the arrangement of various signals and the display of axis
is more or less disordered. To make them more orderly, you can configure a few basic settings in the Scaling
menu and the Toolbar (see Figure 25).

pp Yy E--t -
Figure 25: Scaling buttons in the Toolbar

The following is possible:

= Scaling several signals at the same position in the Y axis

= Scaling X and Y axes manually

= Moving axes in X/Y direction

= Auto scaling X/Y axes with overlapping signals curve

= Auto scaling X/Y axes with Y axes positioned one below the other

= Auto sorting and scaling X /Y axes one below the other

= Auto recolouring signals and scaling X /Y axes one below the other

= Auto scaling Y axes side by side

= Auto scaling X axis

= Stretching the signal along Y axis

Scaling several signals at the same position in the Y axis

First of all, it should be noted that the scaling of the Y-axes occurs independently, differently from signal to
signal, when several signals are displayed. If the shown signals are to be displayed in exactly the same Y-axis
scaling, the Adjust scaling option in the Scaling menu can be used.

To scale the signals at the same position in the Y axis, follow the steps below:

1. Go to the Scaling menu

- Alternatively, you can right-click on the Plot panel and hover the mouse cursor over Scaling
or right-click on the Signal list area.

2. Press Adjust scaling

Scaling X and Y axes manually
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There are two ways of scaling X and Y axes manually: by setting coordinates and by dragging axes.

To scale axes manually by setting coordinates, follow the steps below:

1. Select the signals in the Signal list area.

2. Go to the Scaling menu.

- Alternatively, you can right-click on the Plot panel.
3. Hover the mouse cursor over Y axis or X axis depending on the axis you want to scale.
4. Press Input X or Input Y.

5. In the opened window (see Figure 26) enter values in the fields From and To, to set the range
for all the selected signals.

6. Click OK to confirm.

@ Scaling Y-axis =
From: 2.0
To: 4.0
Cancel Ok

Figure 26: Manual scaling of Y axis

Moving axes in X/Y direction

To move axes manually by dragging axes in both directions, follow the steps below:

1. Select the signals you want to move.
2. Press Alt key and the mouse button.
3. Drag the axis.
To move axes manually by dragging axes in one direction, follow the steps below:
1. Select the signals you want to move.
2. Hover over an axis (left of or below the plot) and hold the left mouse button.
3. Drag the axis.
4. If you grabbed the y-axis, the selected signals are moved in y direction.

5. If you grabbed the x-axis, the whole plot is moved in x direction.
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CAUTION
If no signals are selected, not only one but all the signals will be moved together with the

mouse.

Auto scaling X/Y axes with overlapping signals curve

To scale X and Y axes with Y axis overlap, go to the Scaling menu and press Auto overlap X/Y or follow
the steps below:

1. Go to the Toolbar.

2. Press the second =¥ or fourth J/ scaling button.

Alternatively, you can use the following way to scale X and Y axes with Y axis overlap:

1.  Right-click on the Plot panel.
2. Hover the mouse cursor over Scaling.

3. Press Adjust Y overlap.

As a result, overlapping signals are displayed with X- and Y-axes scaled to fit the signals
completely within the Plot panel (see Figure 27).
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Figure 27: Overlapping signals
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Auto scaling X/Y axes with Y axes positioned one below the other

To scale X/Y axes with Y axis positioned one below the other, go to the Scaling menu and press Auto X/Y
one below the other or follow the steps below:

1. Go to the Toolbar.

2. Press the first = or fifth -} scaling button.

As a result, the Y axis are scaled one below the other (see Figure 28).

b dF~FTIT~-1 1t -~ 28 S ?

Signals

Signal groups

Figure 28: Y axes scaled one below the other

Alternatively, you can use the following ways to scale X and Y axes with Y-axis curves one below the other:
= From the Plot panel:

1. Hover the mouse cursor over Scaling.
2. Press Auto X/Y one below the other.

= From the Scaling menu:

1. Hover the mouse cursor over Y axis.
2. Press Adjust X/Y one below the other.

= From the Plot panel:

1. Hover the mouse cursor over Scaling and then Y axis.
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2. Press Adjust X/Y one below the other.

Auto sorting and scaling X /Y axes one below the other

To sort and scale X/Y axes one below the other, follow the steps below:

1. Go to the Scaling menu.
2. Press Auto sort X/Y one below the other.
NOTE

If the position of the Y axes has been changed manually before sorting the
axes, the manually set order will maintain.

Alternatively, you can use the following ways to sort and scale X/Y axes one below the other:
= From the Plot panel:

1. Hover the mouse cursor over Scaling.

2. Press Auto sort X/Y one below the other.

= From the Scaling menu:

1. Hover the mouse cursor over Y axis.

2. Press Adjust Y axis one below the other sorted.

= From the Plot panel:

1. Hover the mouse cursor over Scaling and then Y axis.

2. Press Adjust Y axis one below the other sorted.

Auto recolouring signals and scaling X /Y axes one below the other

To recolour and scale X/Y axes one below the other, follow the steps below:

1. Go to the Scaling menu.
- Alternatively, you can right-click on the Plot panel and hover the mouse cursor over Scaling.

2. Press Auto colour X/Y one below the other.

Auto scaling Y axes side by side

To scale Y axes side by side, follow the steps below:
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Go to the Scaling menu.

- Alternatively, you can right-click on the Plot panel and hover the mouse cursor over Scaling.
Hover the mouse cursor over Y axis.

Press Auto Y axis side by side.

As a result, the Y-axes will be positioned side by side. That way the signals can be spread

over the full extent.

Auto scaling X axis

To scale X axis automatically, follow the steps below:

1.

Go to the Toolbar.

Press the third =+ scaling button.

Once it is done, only the X-axis is scaled so that the entire measurement is displayed in the

X direction.

Alternatively, you can use the following way to scale X axis in the X direction:

1. Right-click on the Plot panel.
2. Hover the mouse cursor over Scaling and then X axis.

3. Press Auto X.

Stretching the signal along Y axis

To stretch the signal along Y axis, press N key or follow the steps below:

Go to the Scaling menu.

- Alternatively, you can right-click on the Plot panel and hover the mouse cursor over Scaling.
Hover the mouse cursor over Y axis.

Press Stretch Y.

7.2 Zooming axes

IAV Merida Signals provides zooming options to optimize the representation of the axes (see Figure 29).

=5 =g

Figure 29: Zooming buttons

The following is possible:
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= Zooming out along the X and Y axis

= Zooming in along the X and Y axis

= Zooming in by drawing a rectangle

Zooming out along the X and Y axis

To zoom out along the X and Y axis, follow the steps below:

1. Select an individual signal or signals.
2. Go to the Toolbar.
3. Do one of the following:

= Press the first == zooming button to zoom out along X axis.

= Press the third { zooming button to zoom out along Y axis.

Alternatively, you can zoom out along the X axis by using the mouse wheel.

NOTE
% If no signal is selected, the zooming will be applied to all visible signals.

Zooming in along the X and Y axis

To zoom in along the X and Y axis, follow the steps below:

1. Select an individual signal or signals.
2. Go to the Toolbar.
3. Do one of the following:

= Press the second =~ zooming button to zoom in along X axis.

= Press the fourth } zooming button to zoom in along Y axis.

Alternatively, you can zoom in along the X axis by using the mouse wheel.

NOTE
% If no signal is selected, the zooming will be applied to all visible signals.

Zooming in by drawing a rectangle

To zoom in by drawing a rectangle with the mouse:
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1. Hold down the left mouse button.

2. Draw a rectangle.
3. Release the mouse button.
4. The whole plot is zoomed to the selected region.

7.3 Showing and hiding the Y axes

Y-axis can be shown and hidden on the Plot panel. These options can be applied only if Show all Y axes
option in the Graphic menu is not active. When Y axis is hidden, it will no longer be visible in the Plot panel
unless a signal which belongs to the axis is currently selected.

The following is possible:

= Showing or hiding Y axes

Showing or hiding Y axes
To show or hide Y axes, press Ctrl+E/Ctrl4+Q keyboard shortcut or follow the steps below:
1. Select an individual signal or signals.

CAUTION
Make sure that the selected signals are visible on the Plot Panel. Otherwise,
nothing will happen.

2. Go to the Signal menu

- Alternatively, you can right-click on the Plot panel and hover the mouse cursor over Signal.

3. Hover the mouse cursor over Y-axis.
4. Press Show or Hide, depending on which action you want to perform.
CAUTION

If no signal is selected, the options Hide or Show will be applied to Y axes of
all visible signals.

An alternative way to show or hide all Y axes on the Plot panel is to activate the Show all
Y axes option. To do this, follow the steps below:

1.  Go to the Graphic menu.

2. Press Show all Y axes.
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7.4 Operating with views

The Views allow to store different signal representations on the graph. This is particularly useful for visualizing
signals with varying scaling options, enabling convenient comparison and analysis. A view always contains
information about signals to display and their scaling.

The Views allows the following:

= Creating a new view

= Displaying the saved view

= Editing the saved views

= Overwriting the selected view

= Adding visible signals to the selected view

Creating a new view

To create a new view, follow the steps below:

1. Go to the View menu.
2. Press New.
3. In the New view window that opens, enter a view name.

4. Click OK to confirm.

After confirming, the newly saved view will appear in the Views list.

Displaying the saved view

To display the list of the saved views, follow the steps below:

1. Go to the View menu.

2. Hover the mouse cursor over Views.

After that the selected view with its signals in the saved scaling position will be displayed.

NOTE
In the Views list you can find all the views that have ever been saved. However, only signals
that are presented in the currently opened file will be displayed in the selected view.

Editing the saved views

To edit the saved views, follow the steps below:
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1. Go to the View menu.
2. Press Edit.

3. In the Views window that opens, select the view you want to change.

Here it is possible to:

= change the views order in the list by pressing Up and Down
= delete a view by pressing Delete and confirming with OK

= create a new view by pressing New (see Creating a new view)

= export a view by pressing Export
= import a view by pressing Import

= search for a view

Overwriting the selected view

To overwrite the selected view, follow the steps below:

1. Go to the View menu.

2. Press “View name” QOverwrite.

Adding visible signals to the selected view

To add visible signals to the selected view, follow the steps below:

1. Go to the View menu.

2. Press “View name” Append.
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8 Representation settings

8.1 Graphs settings

The representation of the graph on the Plot panel can be set up by using some options in the Graphic menu.

The following is possible:

= Displaying all points on the Graph

= Showing and hiding the Graph' s elements

= Displaying the signal curves with interpolation

= Using dynamic Y axes

= Changing the time values representation on the Graph

Displaying all points on the Graph

If you want to view a measurement with an extremely large numbers of points, some of them may not be
displayed and an error message ‘Not all measurement points are shown!' can appear. It is done to keep
the display speed.

To display all points on the Graph, follow the steps below:

1. Go to the Graphic menu.

2. Press Display all points.

After this function is activated, all points of all signals will be displayed on the Plot panel.

NOTE
% The Display all points option will display all points for just one time in order to avoid
display errors.

Showing and hiding the Graph’ s elements

In the Graphic menu, there is a possibility to show and hide the elements on the Graph such as Lines, Points
and Grid.

To show or hide elements on the Graph, follow the steps below:

1. Go to the Graphic menu.

2. To activate or deactivate a specific element in the Graphic menu (Lines, Points, Grid), toggle
its state by selecting or deselecting the corresponding option.
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Displaying the signal curves with interpolation

To display the signal curves with interpolation, follow the steps below:

1. Go to the Graphic menu.
2. Press Lines interp.
CAUTION
If a smooth curve is to be displayed, it makes sense to deactivate the points and display

the lines with interpolation. If interpolation is not activated, the lines are displayed in a

staggered form.

Using dynamic Y axes

Dynamic Y-axes is a mechanism that aligns the Y axes so that they take up as little space on the plot panel
as possible. The axes are also placed one below another, depending on how far the associated signal extends

in the Y-direction.

To use dynamic Y axes, follow the steps below:

1. Go to the Graphic menu.

2. Press Dyn. Y-axes.

Figure 30 shows an example of a display with dynamic Y-axes. In contrast, Figure 31 shows without dynamic

Y-axes.

NOTE
If the Dyn. Y-axes option is activated, you can change the order of Y axes on the Plot by

dragging it.

Changing the time values representation on the Graph

It is possible to change the representation of time values on X-axis. Time values can be displayed in a date
and time format as follows ‘24.06.2000 13:43:00" or in seconds.

To change the time values representation, follow the steps below:

1. Go to the Graphic menu.

2. Press Time as Date to change time values into a date and time format or Time in seconds

to represent time values in seconds.
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Figure 30: Representation with dynamic Y-axes
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Figure 31: Representation without dynamic Y-axes
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NOTE
If none of the options is selected, time is shown as hours, minutes and seconds.
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9 Exporting measurement data

9.1 Export of signals and messages

Signals and messages can be exported in the form of a file. For this purpose, different formats are supported.

The following is possible:
= Exporting signals

= Exporting messages

= Setting export parameters

= Editing a file comment

Exporting signals

To export signals, follow the steps below:

1. Press Export signals in the File menu or use E key to open the Export signals window (see
Figure 32).
@ x
Speichern in; root v B @ BEEE
(@) All signals
Visual signals
(@ All points
Actual time window
Time start with zero
@ Time as integer
(V) save notes
Statistic frames
Edit comment
Dateiname:
oatetp: wor -

Figure 32: The Export signals window

2. Enter a file name and set export parameters if it necessary (see Setting export parameters).

CAUTION
If you do not modify the export parameters, the exported file will be saved

with the default settings applied.

3. Select an appropriate file format.

4. Click Save to export the signals.

Exporting messages
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Generally speaking, exporting messages works in a similar way to exporting signals. Here it is only necessary
to select the message-based file format —ASC, BLF and PCAPNG are supported. However, it should be
noted that the source measurement must also be based on messages.

To export messages, follow the steps below:

1. Open the File menu and deactivate the Load signals only option.

CAUTION
For exporting to message-based formats, the Load signals only option must
be deactivated before loading the source measurement file.

2. Press Export signals in the File menu or use E key to open the Export signals window (see
Figure 32).
3. Enter a file name and set export parameters if necessary (see Setting export parameters).
CAUTION

If you do not modify the export parameters, the exported file will be saved
with the default settings applied.

4. Select an appropriate message-based file format (e.g., ASC, BLF or PCAPNG).

5. Click Save to export the signals.

Setting export parameters

To set export parameters, follow the steps below:

1. Select the parameter in the right sidebar of the Export signal window.

The following are available:

= All signals - to export all signals.
= Visual signals - to export only visual signals.
= All points - to export values for the whole period.

= Actual time window - to export values only for the area currently displayed in the Plot
panel.

While exporting signals in MDF format, more options are available:

= Time start with zero - to set the exporting start time. If the option is activated, the
time will start from zero. Otherwise, the time will be output as is.

= Time as integer - to set the time values as an integer (by activating the option) or
double.
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= Save notes - to save notes on signals (see 6.2 Notes on the signal).
= Edit comment - to edit a file comment (see Viewing and editing a file' s metadata).

Editing a file comment

With the Edit comment option, an MDF-specific comment can also be written in the file. The comment of
the currently opened file (only with MDF) can be displayed with the Display comment option in the Signal

menu.

To edit a file comment, follow the steps below:
1. Press Edit comment.
2. Make changes in the Comment window.

3. Click OK to confirm.

9.2 Graphic export

The following is possible:

= Graphic exporting

Graphic exporting
The current view in the Plot panel can be exported as PNG and SVG graphs.
To export the graphic, follow the steps below:

1. Press Graphic export in the File menu.
- Alternatively, you can press Graphic export in the Graphic menu or right-click on the Plot

panel and then press Graphic export in the Graphic menu.

The Graphic export window will appear (see Figure 33).

X

Speichern in root v moamBs
Size
800 O
600 O
Dateiname:
Dateityp: PNG (+.png) “—

Figure 33: The Graphic export window

Enter a file name, file type and set the size of the downloaded graphics (in pixels) if necessary.

3. Click Save to export the graphic.
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9.3 Signal list export

The signal list of a measurement file can be exported in a text format. This list of signals can be used in

other tools.

The following is possible:

= Exporting signals as a list

Exporting signals as a list

To export signals as a list, follow the steps below:

1. Press Export signals as list in the Signal menu.

- Alternatively, you can right-click on the Plot panel and press Export signals as list in the

Signal menu.

2. Enter a file name in the opened window.
3. Click Save to export the signal list.
NOTE

The exported signal list can be later used when opening a measurement file with the option
of a signal list preview. This means that a previously exported signal list (via the ‘Export
signals as a list’ option) can be imported into the ‘Signal selection’ window to promptly
mark the signals that need to be displayed. For more information on how to import a signal
list, see Importing and exporting a signal list.
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10 Tools

IAV Merida Signals provides a variety of tools for working with measurement files, offering the following

capabilities:

= Determining the most appropriate channel for DBC files (see Platform detection for DBC files).

= Viewing CAN message statistics (see CAN messages statistics).
10.1 Platform detection for DBC files
The Platform detector can be used to detect the most appropriate channel for a DBC file.

Using the Platform detector, the following is possible:

= Detecting an appropriate channel

= Filtering the estimation results

= Saving settings as a new platform

= Deleting a data description file

Detecting an appropriate channel

To detect an appropriate channel, follow the steps below:

1. Press Platform detector in the Tools menu.

After it is done, the Platform detector window is opened (see Figure 34).

@ piatform detector x

RoEy

Bus Quality Known Unknown  (Total)

Figure 34: The Platform detector window

2. Press Folder icon [ and add a measurement file (frame-based).

After it is done, a measurement file appears in the window.

3. Press New decoder icon [ and add data description files.

4. Press Start icon [> at the right corner of the window to run the detection.

When the processing ends, the list of channels that can be used to open a file is provided

together with:
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= Quality (%) - the estimations of how suitable a particular channel is.

= Known and Unknown - the number of CAN messages that can and cannot be decoded

correspondingly.

= Total - the total number of messages in your DBC file.

NOTE

= For some measurement files another small window appears where a data format must
be specified.

= If a measurement file is quite large, it is also possible to pause the detection by
clicking on the Start icon once again and to view intermediate results.

Filtering the estimation results

The estimation results of Quality value can be filtered to see the most and the least relevant channels for
DBC files with the help of the Filter function.

To filter the estimation results, follow the steps below:
1. Press Filter icon ¥

2. Drag a slider ¥/ to set the Quality value.

- Alternatively, you can enter a particular number in the square next to the slider.

Saving settings as a new platform

To save the selected settings as a new platform, follow the steps below:

1. Select the channels by ticking a box.
2. Press Save icon
3. Enter a platform name in the opened window.

4. Click OK to confirm the saving.

After saving, the platform appears in the Platform dialog box (to see it, press P keyboard
key).

Deleting a data description file

To delete a data description, follow the steps below:
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1. Select the file name by clicking on it.

2. Press Delete icon @7 in the menu.

10.2 CAN messages statistics

IAV Merida Signals allows viewing statistics on CAN channels presented in frame-based measurement files.

The following is possible:

= Viewing statistics on CAN channels

Viewing statistics on CAN channels

To view statistics on CAN channels, follow the steps below:

1. Press CANStat in the Tools menu.

2. Select a measurement file (frame-based) on your computer and press Open.

After it is done, the CAN statistics window opens (see Figure 35). Here you can view such data as

CAN channel, message ID and the total number of CAN messages contained in the file.

Can [} count.
469537281 / 0x1bfc9201 3552
389220880 / 0x17330a10 5
178 7 0xb2 427
389220880 / 0x17330a10 s
549  0x3b5 a3
253 / 0xdd 214
178 [ 0xb2 427
178 7 0xb2 427
260 / 0x104 214
1328 / 0x530 22
253  0fd 214
253 / 0dd 214
253 / 0xfd 214
949 / 0x3b5 a3
260 / 0x104 214
1513/ 0x5e9 22
278 / 0x116 214
260 / 0x104 214
1640 / 0x668 22
914 / 0x392 43
278/ 0x116 214
278/ 0x116 214
779/ 0x30b 86
175 / Oxaf a17
1640 / 0x668 22
914 / 0x392 43
779 / 0x30b 86

Figure 35: The CAN statistics window

CAUTION
In some cases, to open statistics a data format must be first specified.

NOTE
By clicking on the column name, the values presented in the dialog box, can be sorted in
descending and ascending order.

IAV Merida Signals = 2.2605.1584346 = 05/18/2026

69



11 Interface language settings

IAV Merida Signals interface supports German and English languages.

The following is possible:

= Changing the interface language

Changing the interface language

To change the interface language, follow the steps below:

1. Go to the Language menu.
2. Select the desired one by clicking on it.
CAUTION

To change the interface language, Merida Signals must be restarted.
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12 Help

In the Help menu, you can find supplementary information about IAV Merida Signals.

The following is possible:

= Viewing the IAV Merida Signals manual

= Requesting the support

= Renewing licence

= Viewing IAV Merida Signals changelog

= Viewing IAV Merida Signals information

Viewing the IAV Merida Signals manual

To view the IAV Merida Signals manual, follow the steps below:

1. Hover the mouse cursor over Manual in the Help menu.

2. Select the manual in the desired language.

After one is selected, the manual opens in PDF format.

Requesting the support

To request the technical support, follow the steps below:

1. Press Contact support in the Help menu.

After it is done, your e-mail client opens automatically.

2. Enter the subject line and your request.

CAUTION
Be sure the subject line is filled and specifies your request.

3. Press Send to e-mail the technical support team.

Renewing licence
You can request for another 180 days of activation once your current activation period expires.

To renew licence, follow the steps below:
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Warning x
0 Are you sure you want to renew the license?

Note: After the restart of the application Merida Signals stops warking until
you request and

receive a new license code from merida-support@iav.de. This process cannot be
undone

Figure 36: The Confirmation window

1. Press Renew Licence in the Help menu.

After it is done, the confirming window opens (see Figure 36).
2. Click OK to confirm.

After confirming, IAV Merida Signals will be closed.

NOTE

When you send this request, the current activation will be deactivated and you
will only be able to use IAV Merida Signals again after reactivation.

3. Restart Merida Signals and request a new license (see Activating Merida Signals to get fa-
miliarized with the activation process).

Viewing IAV Merida Signals changelog

To view IAV Merida Signals updates, follow the steps below:

1. Go to the Help menu.

2. Press Changelog.

After it is pressed, the Changelog window opens (see Figure 37). Here you can view information
about Merida Signals releases (their versions, fixed bugs and new features).

Viewing IAV Merida Signals information

To view AV Merida Signals information, follow the steps below:

1. Go to the Help menu.

2. Press Info.

After it is pressed, the Info window opens (see Figure 38). Here you can find quick information
about the latest update and support contacts.
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@ changelog x

Release 2,2605

Bugs fixed

New features

Release 2.2604
Bugs fixed

- An error n the definition of virtual signals has been fixed.
« An error that occurred while updating colors has been fixed.

New features

Release 2,2603

Bugs fixed

« An error in the display of signals in the signal selection dialog has been fixed,
« An issue with color handling during graphics export has been fixed,

« An error in setting the language has been fixed

New features

« & new feature allows shifting measurements in time to compensate for time zone
differences.
« Compression methods introduced with MDF version 4.3 are now supported.

Release 2.2602
Bugs fixed

« Inputs for CAN and LN signals are checked for validity.

Figure 37: The Changelog window

Info *

o 1AV Merida Signals

(c) 1AV GmbH
Version number 2.2605.1584346 from 2026-05-18 10:38:06

License Terms
Privacy Policy.

Support:
Tel: +49 5371 80 - 53518
E-Mail: merida-support@iav de

Figure 38: The Info window
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13 Operating Merida Signals via Keyboard

This section describes all the keys and key combinations that will help you quickly operate Merida Signals

functions.

Function in Merida Sig-
nals

Description

Key/Keyboard shortcuts

Reference to the manual

Select all Select all the signalsinthe  CTRL + A Displaying signals on the
Signal list Plot panel
Search Basic search for signals F1 Searching for signals
Search with RegEx Search for signals with F11 Searching for signals
regular expressions
Switch list Switching from one signal M Switching between signal
group to another in the groups
Signal list area
Toggle extended info Show or hide all additional ~ CRTL+I Showing and hiding addi-
parameters in the signal tional information on sig-
names nals
Colour Change a colour of these- F Changing the colour of se-
lected signals lected signals
Recolour visible signals Recolour visible signals CTRL + F Recolouring visible signals
Info View signal information | Viewing signal informa-
tion
Trace window Open the Trace window T Trace window
Cursor Display a single cursor Period Viewing signal values with
Single cursor
Two cursors Display a double cursor Comma Viewing signal values with
Double cursor
Add Add note to the signals Ctrl +H Adding a note
Display notes Display the signals notes A Adding a note
Remove Remove signal from the Delete Removing a note

Plot panel
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Function in Merida Sig-
nals

Description

Key/Keyboard shortcuts

Reference to the manual

Adjust scaling Scale the signals at the F2 Scaling several signals at
same position in the Y and the same position in the Y
X axes axis

Input Y Scale Y axes manually by  Shift+Y Scaling X and Y axes
setting coordinates (from, manually
to)

Input X Scale X axis manually by  Shift+X Scaling X and Y axes
setting coordinates (from, manually
to)

Auto overlap X/Y / Ad-  Auto scale X/Y axes with  Shift+W/ W Auto scaling X/Y axes

just Y overlap overlapping signals curve with overlapping signals

curve

Auto X/Y one below the Auto scale X/Y axes with B Auto scaling X/Y axes

other Y-axis curves one below with Y axes positioned
the other one below the other

Auto sort X/Y one below  Auto sort and scale X/Y  Shift+V/V Auto sorting and scaling

the other axes with Y-axis curves X /Y axes one below the
one below the other other

Auto colour X/Y one be-  Auto recolour signals and  Shift+F Auto recolouring signals

low the other scale X /Y axes one below and scaling X /Y axes one
the other below the other

Stretch Y Stretch the signal alongY N Auto scaling Y axes side
axis by side

Show Show Y axes on the Plot  Ctrl+E Auto scaling X axis
panel

Hide Hide Y axes on the Plot Ctrl+Q Stretching  the  signal

Function in Merida Sig-
nals

panel

Description

Key/Keyboard shortcuts

along Y axis

Table 2: Scaling configuration

Reference to the manual

Export signals

Signals and messages ex-
port
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E

Exporting signals

Table 3: Exporting measurement data
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14 Troubleshooting

Signals are not displayed

Issue: When opening a message-based measurement with ‘data description’ selected, the expected signals
are not displayed.

Solution: Check that all data descriptions have been applied to the correct channels (see Configuring a platform).

NOTE
IAV Merida Signals integrates data descriptions for each individual channel.

RegEx search returns no results

Issue: When using a search with the regular expression (e.g. ““start*end$'), the expected result is not

displayed. The list of signals is empty.

Solution: When using regular expressions, the asterisk (*) is commonly used as a repetition symbol. How-
ever, if you are looking for a wildcard character that represents multiple symbols, you can use "*" (e.g.
“start.*end$'). This combination allows you to match any character or sequence of characters in the speci-

fied position.

Error ‘null InvalidPathException’

Issue: A measurement file does not open and the error message "null InvalidPathException” is displayed.

Solution: Make sure that your measurement file and its corresponding data description, which were config-
ured earlier, retain their original file paths and still exist on your device. If either of these files is deleted or
moved to another folder, an error message may occur. This issue arises due to the disruption of settings in
the previously configured platform.

Not all signals are displayed

Issue: After a message-based measurement file is opened and the Platform is configured, no signals but
'UTCTime’ and 'arrayVariable' are displayed.

Solution: To open and view signals from your measurement file, make sure that an appropriate platform is
chosen. If the platform is not chosen, only certain signals as '"UTCTime' and/or 'arrayVariable' are displayed.
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No possibility to choose a platform

Issue: After selecting a decoder with the matching channel, the OK button is not active, only 'Cancel’ and
'Skip’ can be selected.

Solution: To choose a platform, you should first select the platform name and confirm your choice by pressing
the OK button. If you ignore this step or select the channel name first, the OK button will be unavailable.

Merida Signals does not start

Issue: Merida Signals is not launching.

Solution: Most common it can occur due to an outdated version of Merida Signals. To resolve the
issue, update Merida Signals to the latest version. If the issue persists, contact our support team at
merida-support@iav.de.
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15 Uninstallation the software

If you need to remove the IAV Merida Signals from the computer, it can be done with the help of Uninstaller.

To uninstall IAV Merida Signals, follow the steps below:

1. Find IAV Merida Signals in the Start menu.
2. Right-click on the tool.

3. Select Uninstall.
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Glossary

ASC
Proprietary logging format designed by the company Vector. 13

BLF

Proprietary logging format designed by the company Vector. 13

CAN

Controller Area Network is a bus system. 4

CAN message
Messages on the CAN. 13

Data description

Files that do not contain data in the actual sense, but metadata. For example, a data description can
contain the information in which CAN message and in which form a certain signal was transmitted.
13

Data loggers

Measuring device for recording CAN messages. 13

DBC
The database CAN file format for describing CAN messages. 4

IAV Merida Signals

IAV Merida Signals is a tool designed for viewing measurement files from the vehicle. 4

MDF

Measurement Data Format (MDF) is a binary file format for measurement data that was developed
by Vector in collaboration with Robert Bosch GmbH in 1991. 4

Message

Data packets transmitted in bus systems such as CAN. 13

Platform

In 1AV Merida Signals, a platform is the set of data descriptions needed to open a measurement from
a specific measuring device with a specific configuration. 13

Plot Panel

In 1AV Merida Signals, the plot panel is the window where measurement signals are displayed. 56
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